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The Reports User Guide provides an overview of the Oracle Instantis EnterpriseTrack reports 
module. It shows you how to generate and modify standard, Ad-hoc, and user-defined reports. 

 

In This Section 

Document Conventions ............................................................................................. 7 
 
 

Document Conventions 

The following conventions are used in this manual to convey instructions and information:  

The description of a menu item and its sub-items is described in this document as (Page Menu) 
View > Toolbar >Display Print-Data Toolbar, where you should click on the View Page Menu, 
then find the Toolbar sub-item and then click on the Display Print-Data Toolbar sub-item. 

 Screen names and field names are in bold text. 
 The actions you need to take on each screen are in bold text. 
 

In This Section 

Navigating within EnterpriseTrack ............................................................................. 7 
Navigating to the Reports Module ............................................................................. 9 
 
 

Navigating within EnterpriseTrack 

Login to the EnterpriseTrack system using the account your System Administrator has set up for 
you. The menu system consists of an Application Level Menu, Module Level Menu, Page Level 
menu and an Item Level Menu. Common functions are grouped together throughout the 
application. 

Application Level Menu: Appears in the Top Navigation Bar and provides access to all major 
modules and components of EnterpriseTrack. 

About this Manual 

Getting Around in EnterpriseTrack 
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Module Level Menu: Appears as the right most item on the left side of the Top Navigation Bar. 
This menu appears when you are in a specific module of the application, specifically within a 
particular Idea, Proposal or Project. It provides access to commonly used functions within the 
module. 

Page Level Menu: Appears within each page of a module and provides access to functions that 
are relevant only to that page. 

Item Level Menu: Appears within each page in lists of items like activities on the Roadmap (WBS) 
page. It allows you to perform actions specific to that item. 

Using the Top Navigation Bar 
The Top Navigation bar is active when you log into the system. It contains the Application Level 
menu and depending on the context, a Module Level menu. 

 The  Home button takes you to your default home page and is set by you Administrator. 
When the Left Navigation bar is hidden, it is displayed on the blue banner. When the Left 
Navigation bar is displayed, the Home button is displayed on the Left Navigation bar. 

 The Go To menu provides access to all major modules within the EnterpriseTrack system. 
The items displayed in this menu depend on the features enabled for your deployment and 
your permissions. 

 The Create menu displays menu options to create a new project, proposal, idea, program, 
resource or message, etc. 

 The My EnterpriseTrack (terminology is configurable) menu displays options that take you to 
your specific actions and settings. It shows your work (all open actions on Projects, Proposals, 
Ideas etc. that are assigned to you), your messages, certifications, permission, profile, 
preferences and passwords. 

 The View menu allows you to display toolbars at the Top banner, and Left Navigation bar. You 
can also save your settings. 

 The project type ahead text box provides easy navigation to any project in the system. 
 In the text box Type Project ID or name, you can type the Project ID or any part of the name 

and as you type, the system gives you project choices that match the ID or name you are 
typing. 

 The Advanced Search menu gives you different ways for searching the system. You can 
search on projects, proposals, documents, etc. 

 From the Help menu, you can launch the online help in a new window or launch User 
Productivity Kit (UPK). 

 Click on Logout at any time to log out of the application. 

Using the Left Navigation Bar 
To display the Left Navigation bar, from the Top Navigation bar select the View menu and choose 
Display Left Navigation. Select if you want to display icons only or icons and text. The Left 
Navigation bar provides access to all modules in the EnterpriseTrack system. The list of menu 
items displayed depends on the features enabled for your deployment and your permissions. As 
you drag the mouse over these items, you will see the clickable items change color. Current 
selections are always highlighted. Clicking on any of these options typically takes you to a listing 
page with summary information. 
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Use this  button to expand and collapse the Left Navigation bar to shows icons and text or just 
icons. 

Important! 
Do not use the browser's Back and Forward buttons to navigate to a 
different page. Use the left navigation bar and/or the buttons provided 
within EnterpriseTrack. 

 
 

Navigating to the Reports Module 

To navigate to the Reports module, from the Top Navigation bar select Go To > Reports> View. 
 

Standard reports are pre-defined cross-project reports that you can view, run, filter, save, manage, 
and customize. You can restrict these reports to either an initiative, or across multiple initiatives. 
You can choose to run these reports as is, or you can modify the filter and output parameters 
before running these reports. You can also share, schedule reports to run on a scheduled day or 
time, email the generated report, and view the report history. 

In This Section 

Working with Standard Reports ................................................................................. 9 
 
 

Working with Standard Reports 

To access Standard Reports, select Go To > Reports > Standard from the Top Navigation bar, or 
select Reports >Standard from the Left Navigation bar. The reports are organized into folders.  

 My Reports folder contains all reports that you have created. 
 Shared Reports folder contains all reports that have been shared by other. 
 Pre-defined Reports folder contains all reports that have been already created in the system. 
 Global Reports folder contains all the global reports. 
 Custom Reports folder contains all reports that are customized for your system. 

 

 

About Standard Reports 
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In This Section 

Running Standard Reports ...................................................................................... 10 
Saving and Customizing Standard Reports ............................................................. 10 
Deleting Reports ..................................................................................................... 16 
Copying Reports ..................................................................................................... 16 
Managing Report Folders ........................................................................................ 16 
Pre-defined Standard Reports................................................................................. 17 

 
 

Running Standard Reports 

To run a standard report:  

1) Select Go To > Reports > Standard from the Top Navigation bar, or select Reports 
>Standard from the Left Navigation bar. 

2) From the Tree pane, select a reports folder.  
3) From the List pane, select a report. 
4) Click  Run Report to run the report using existing filters and output parameters. Click  

Run with Filters to modify filters or output parameters.  
5) To modify filters: 

a. From the Details pane, select the Filters tab. 
b. Click  Expand All to expand the filter categories. 
c. Modify the filters. 
d. Click Run. 

6) To modify output parameters:  
a. From the Details pane, select the Output tab. 
b. Select an output format. 
c. Choose additional output parameters 
d. Click Run. 

 

Saving and Customizing Standard Reports 

Saving Reports 
You can save an existing standard report to customize settings. You can: 

 Modify the name of the report 
 Select and save the filter parameters and output criteria. 
 Select filter and output parameters that are visible and editable when reports are run. 
 Schedule run frequency. 
 Manage run report history. 
 Share reports. 

All reports you save are displayed under the My Reports folder.  
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To save and customize a standard report: 

1) Select Go To > Reports > Standard from the Top Navigation bar, or select Reports 
>Standard from the Left Navigation bar. 

2) From the Tree pane, select a reports folder.  
3) From the List pane, select a report. 
4) From the Details pane, select Save As. 
5) In the Save the Report As window: 

a. Select a folder name, or enter a name to create a new folder under My Reports. 
b. Enter a name for this report. 
c. Click Save. 

 

Selecting Filter Parameters 
You can selectively narrow the filters and output options to enable only a subset of these settings 
to be editable, visible or editable/visible when reports are run. To select the filter parameters that 
you want to view and edit when this report is run: 

1) From the Tree pane, select My Reports. 
2) From the List pane, select a report. 
3) To select the filters you want visible and editable during runtime: 

a. From the Details pane, select the Filters tab. 
b. Click Edit. 
c. Click the Visible check box next to filter parameters you want visible. 
d. Click the Editable check box next to filter parameters you want to edit. 

4) Click Save. 
 

Selecting Output Parameters 
To select the output parameters that you want to view and edit when this report is run: 

1) From the Tree pane, select My Reports. 
2) From the List pane, select a report. 
3) To select the output parameters you want visible and editable during runtime: 

a. From the Details pane, select the Output tab. 
b. Click Edit. 
c. Click the Visible check box next to parameters you want visible. 
d. Click the Editable check box next to parameters you want to edit. 

4) Click Save. 
 

Scheduling and Emailing Reports 
You can choose to run reports manually or on a schedule. If you select scheduled, you can decide 
the following options: 

 The run frequency you want to use. 
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 Receive email notification when the report is run. 
 Include the report as an email attachment when email notification is sent. 

To schedule a report: 

1) From the Tree pane, select My Reports. 
2) From the List pane, select a report. 
3) From the Details pane, select the Schedule and Email tab. 
4) On the Schedule and Email tab: 

a. Click Edit. 
b. Select the run type: Manual or Scheduled. 

5) If you selected Scheduled: 
a. Select the day of the week, date, month and year to configure the run frequency. 
b. Choose if you want to email this report. 
c. Choose if you want send the report as an attachment. 
d. Select or enter the email addresses 

6) Click Save. 
 

Saving Report History 
You can select how often you want to save the run report history. The report history shows the 
number of times the selected report was run, if it was a scheduled or a manual run, the format of 
the report, and the report output. If the report is shared, it also lists the users who ran the report. 

To save report run history: 

1) From the Tree pane, select My Reports. 
2) From the List pane, select a report. 
3) From the Details pane, select the History tab. 
4) On the History tab: 

a. Click Edit. 
b. Select how often you want to save the report history. 

5) Click Save. 
 

Viewing Report History 
The report history shows the number of times the selected report was run, if it was a scheduled or 
a manual run, the format of the report, and the report output. If a report is shared, it also shows the 
names of people who ran the report. 

To view the report run history: 

1) From the Tree pane, select My Reports. 
2) From the List pane, select a report. 
3) From the Details pane, select the History tab. 
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Using Finance Aggregate Report Filters 
The table below lists the additional filters that are associated with the Project Finances Group 
Aggregate, Project Finances Element Aggregate, and the Project Finances Element Monthly 
Detail reports. The (Set 1) and (Set 2) are two sets of filters for two sets of output columns in the 
Finance Group Aggregate and the Finances Element Aggregate reports. The two sets allow you to 
compare finance aggregate values. You can independently set three filters for each set. 

Finance Aggregate Report Filters 

Filters Pull-down Values Description 

Date 
Range 

 

The range of months that are used to 
generate the aggregate value of the 
Total, Group1, Group 2 etc., columns 
in the aggregate reports. For Monthly 
reports, this determines the months 
that will be populated in the output, all 
other months will have 0 values. 
For Annual totals, use one of the 
different Fiscal Year choices. For 
Quarterly totals, use one of the 
different Quarter choices. If you want 
totals for a particular month, use one 
of the Month choices. For a range of 
months, use "Any Start or End 
Month" 
You can choose aggregation of past 
or future months. 

Finance 
Dataset 

 

This filter determines which set of 
month-by-month values for the 
Date Range specified above are 
considered for aggregation in the 
Aggregate reports, and which finance 
values are fed into the 
month-by-month columns as 
non-zero in the Monthly reports. 
For each project, the system displays 
by default the "Current" values in the 
Finance page, and is automatically 
updated from the Project Activities or 
from the Project Team Finances 
(provided the Finance Template has 
been configured to receive these 
values). You can also take Snapshots 
of the "Current" value and store this 
as a "Plan" and not have it updated 
as edits are made or as the Project 
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Filters Pull-down Values Description 
Activity and Project Team finances 
change. 
This Filter allows you to select which 
Dataset (Current or Plan) you are 
interested in outputting in the report. 
If you are using Lock months to lock 
finances, the filter also allows you to 
consider the Lock month in 
generating the aggregate for the 
other months. For example, you can 
choose to take values from before the 
Lock month if you go through a 
finance validation that ensures that 
the numbers before the Lock month 
have been checked. 
Further, the filter allows you to also 
consider this month (when the report 
is run) and take the Plan values from 
before this month and the Current 
values from after (and including) this 
month. 

Snapshot 
for Plan 

 

If the Finance Dataset filter refers to a 
Plan value, then the "Snapshot for 
Plan" further defines which of the 
Snapshots should be used for the 
report output. 
The Default Plan Snapshot is always 
at the top of the list. 
The system shows the complete list 
of all Snapshots taken in the 
drop-down list (up to a limit of 100). 
To ensure consistent aggregation of 
values, it is recommended that all 
users that make snapshots use a 
consistent naming scheme. 
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Filters Pull-down Values Description 

Finance 
Detail 
Level 

 

The filter sets the level of detail of the 
Finance element hierarchy that is 
shown in the report. This also sets the 
number of rows in the output per 
project. 
Total: means show only the top level 
(Total). 
Group: means show the Group level, 
one level below Total (up to 5, 
depends on number of Groups 
configured) 
Category: means show the Category 
level, 2 levels below Total 
Element: means show the Element 
level, 3 levels below Total 

Show 
Upper 
Levels 

 

This filter decides if the output should 
show higher levels of the 
Finance items hierarchy when a 
lower level item is chosen in the 
Finance Detail Level filter above 
This is relevant if you are doing your 
own aggregation of the element level 
values using Excel and you do not 
want the Category, Group, Total level 
values to interfere with this 
aggregation. 

The table below describes the additional output parameters for the Project Finances Element 
Monthly Detail report. 

Output 
Parameters 

Description 

Starting 
Month 

Enter the starting month. This output setting decides which set of months 
will be shown in the report output. 

Number of 
Months 

Enter the number of months. For instance, you may set the number of 
months to 36 starting with January 2010 for several runs of this report. 
Then depending on the Date Range filter setting (above) varying sets of 
months of these 36 will be populated for different runs of the report. 
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Output 
Parameters 

Description 

Break down 
Finance 
Details by 
Organization 

Select this check box to expand the finance details by organization. Each 
finance line item in the report is expanded and broken down to show the 
finance allocation by organization. 
Note: This report is usable only if the finance allocation percent totals 
100%. The system displays a warning message if it does not equal 
100%. 

 
 

Deleting Reports 

To delete a report: 

1) From the List pane, select a report. 
2) Click  Delete. 
 

Copying Reports 

To copy a report: 

1) Select a report from the List pane. 
2) Click  Copy.  
3) From the Tree pane, select a folder under My Reports. 
4) From the List pane, click  Paste. 
 

Managing Report Folders 

You can copy an existing report folder to edit the folder name, add reports, delete reports, and 
adjust filters and output parameters. 

To copy a report folder: 

1) From the Tree pane, select the report folder you want to copy. 
2) Click  Copy. 
3) Select the My Reports folder. 
4) Click  Paste. A copy of the selected folder is now in your My Reports folder. 
5) From the Details pane, click  Edit to change the name of the folder. 

To delete a report folder: 

1) From the Tree pane, select the reports folder. 
2) Click  Delete.  
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Pre-defined Standard Reports 

Listing Reports 

In This Section 

Idea Listing Report .................................................................................................. 17 
Charter Request Listing ........................................................................................... 18 
Project Listing .......................................................................................................... 19 
Project Listing Report with Activity List .................................................................... 20 
Resource Listing...................................................................................................... 20 
Project Status .......................................................................................................... 21 
Resource Status ...................................................................................................... 22 
Activity Detail Report ............................................................................................... 23 
Metrics Listing Report .............................................................................................. 24 
Project & Metrics Template ..................................................................................... 25 
Non-WBS Activity Report ........................................................................................ 26 
 
 

Idea Listing Report 
Based on your filters, this report displays all ideas in the system. It displays the idea number, title, 
status, description of problem/opportunity, division, business unit, primary contact, assignee, 
submission date, date accepted/rejected, and the evaluation score.  

Filter Parameters 

You can filter on pull down status, idea basics, organization hierarchy and idea custom fields. 

Output Parameters 

You can select the primary output column to sort by, sort direction, number rows to display per 
page, maximum number of rows to display per report, and if the output should be compressed. 
The output choices are CSV, PDF and HTML.  
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Sample Report 

 
 

Charter Request Listing 
Based on your filters, this report displays all charter requests in the system. It displays the charter 
ID, name, status, project type, roadmap, division, business unit, manager, planned start date, 
actual start date, planned project close date, initial forecast benefits, initial forecast cost, and the 
evaluation score.  

Note: Depending on your configuration, the Project Request Listing is the 
same as Charter Request Listing Report label. 

Filter Parameters 

You can filter on pull down status, initiative, proposal basics, classification fields, and organization 
hierarchy. 

Output Parameters 

You can select the primary output column to sort by, sort direction, number rows to display per 
page, maximum number of rows to display per report, and if the output should be compressed.  

The output choices are CSV, PDF and HTML.  
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Sample Report 

 
 

Project Listing 
Based on your filters, this report displays all projects in the system. It displays the initiative, phase, 
status, start date, forecast, functional area, and region. 

Filter Parameters 

You can filter on pull down status, initiative, project basics, project dates, organization hierarchy, 
finances, project custom fields, classification fields, and alignment tree. 

Output Parameters 

You can select the primary output column to sort by, sort direction, number rows to display per 
page, maximum number of rows to display per report, and if the output should be compressed.  

The output choices are CSV, PDF and HTML.  

Sample Report 
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Project Listing Report with Activity List 
Based on your filters, this report displays project details and project activity details like the activity, 
type, sub type, path, name, status, status indicator, number of attachments, tollgate activities, 
owner and dates (plan start, plan completion, actual start, and actual completion). 

Filter Parameters 

You can filter on pull-down status, initiative, project basics, project dates, organization hierarchy, 
project custom fields, and activity details like the type, name, status, number of attachments, 
dates, and the status of milestones. 

Output Parameters 

You can select the primary output column to sort by, sort direction, number rows to display per 
page, and maximum number of rows to display per report.  

The output choices are CSV, PDF and HTML. 

Sample Report 

 
 

Resource Listing 
Based on your filters, this report displays all resources. It displays the name, resource type, 
resource sub type, email address, phone number, access profile, allowed roles, division, business 
unit, region, manager, and initiative. 

Filter Parameters 

You can filter on pull-down status, initiative, resource basics, and organization hierarchy. 

Output Parameters 

You can select the primary output column to sort by, sort direction, number rows to display per 
page, maximum number of rows to display per report, and if the output should be compressed.  

The output choices are CSV, PDF and HTML. 
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Sample Report 

 
 

Project Status 
Based on your filters, this report displays the status of projects. It displays the ID, name, status, 
team size, timesheets, related entities #, and activities # with milestones and key milestones.  

Filter Parameters 

You can filter on pull down status, initiative, project basics, project dates, organization hierarchy, 
finances, project custom fields, classification fields, and alignment tree. 

Output Parameters 

You can select the primary output column to sort by, sort direction, number rows to display per 
page, maximum number of rows to display per report, and if the output should be compressed.  

The output choices are CSV, PDF and HTML. 
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Sample Report 

 
 

Resource Status 
Based on your filters, this report displays the status of resources. It displays the name, login ID, 
status, last login date, timesheets, last timesheet submission date, and related entities.  

Filter Parameters 

You can filter on initiative, resource basics, and resource filterable custom fields. 

Output Parameters 

You can select the number rows to display per page, maximum number of rows to display per 
report, and if the output should be compressed.  

The output choices are CSV, PDF and HTML. 
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Sample Report 

 
 

Activity Detail Report 
This is a detailed report on each activity associated with a project. You can filter on initiative, 
program, all project activities, LET (Labor Expense Type) categories, and resource related fields. 
You can use the output generated from this report to create custom User-Defined Excel reports to 
view activity-related information for a specific project or group of projects. The output includes LET 
and labor expense categories. 

Filter Parameters 

You can filter on pull-down status, initiative, project basics, project dates, project organization 
hierarchy, project methodology, project custom fields, project classification fields, program, project 
alignment tree, activity, activity custom fields, and resource basics. 

Output Parameters 

You can select the maximum number of rows to display per report, resource details, and the WBS 
code column. To view resource information split into multiple rows per project, with each resource 
role displayed in separate rows, select Yes for Resource Details. If you select No for Resource 
Details, then each activity with all its assignments is contained within a single cell in that row. 

The output choices are CSV, MS Excel, PDF, and HTML. 
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Sample Report 

 
 

Metrics Listing Report 
Use the Metrics Listing report to display project metrics based on your filters. 

Filter Parameters 

You can filter to show metrics for a specified date range and select the recent number of metric 
data entries (1 to 50) to display. 

Output Parameters 

You can select the output columns, the column to sort by, and the sort order.  

The available report formats are: CSV, HTML, and PDF. 
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Sample Report 

 
 

Project & Metrics Template 
Use the Project & Metrics Template report to display project metadata and details of associated 
metrics. 

Filter Parameters 

You can filter on initiative, organization hierarchy, project classification fields, project basics, and 
metrics. You can filter to show metrics for a specified date range and select the recent number of 
metric data entries (1 to 50) to display. 

Output Parameters 

You can select the output columns, the sort by column, and the sort order.   

The available report formats are: CSV, HTML, and PDF. 
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Sample Report 

 
 

Non-WBS Activity Report 
Use the Non-WBS Activity report to display a detailed list of all non-WBS activities configured in 
your system. It also displays custom fields that are specific to non-WBS activities. 

Filter Parameters 

You can filter on pull-down status, initiative, project basics, project dates, organization hierarchy, 
project custom fields, alignment tree, programs, activities, activity custom fields and resource 
basics. 

Output Parameters 

The available report formats are: CSV, HTML, MS Excel, and PDF. You can also select the 
maximum number of rows to show per report.  
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Sample Report 

 
 

Project Reports (Summary Reports) 

In This Section 

Finance Summary Report ........................................................................................ 27 
Project Summary By Organization ........................................................................... 28 
Project Summary By Organization ........................................................................... 28 
Project Summary By Project Source........................................................................ 29 
Project Summary By Functional Area ...................................................................... 29 
Project Summary By Process Area ......................................................................... 30 
Project Summary Stats by Role ............................................................................... 30 
Closed Project Listing .............................................................................................. 31 
Active/Closed Project Report ................................................................................... 32 
 
 

Finance Summary Report 
Based on your filters, this report displays the finance summary. It displays the finance categories 
and based on your filters the realized or forecast finances for each fiscal year. Before running this 
report, you must choose a Finance Template and the Finance Type from the Filter tab.  

Filter Parameters 

You can filter on pull-down status, initiative, finances, project basics, project dates, organization 
hierarchy, project custom fields, classification fields, and alignment trees. 

Output Parameters 

The available report formats are: CSV, HTML, and PDF.  

  27 

 



Reports User's Guide  
 

Sample Report 

 
 

Project Summary By Organization 
Based on your filters, this report displays the finance summary by organization. Before running 
this report, you must choose a Finance Template from the Filter tab. For each division it shows the 
project count (active, closed, and total), project finances, resource count and project lead count. 

Filter Parameters 

You can filter on pull-down status, initiative, finances, project basics, project dates, organization 
hierarchy, project custom fields, classification fields, org hierarchy display options and alignment 
trees. 

Output Parameters 

The available report formats are: CSV, HTML, and PDF.  

Sample Report 

 
 
 

Project Summary By Organization 
Based on your filters, this report displays the project summary by alignment. It displays the 
alignment, project count (active and closed) and the project finances. Before running this report, 
you must choose a Finance Template, the Finance Type (Plan or Actual), the Alignment List and 
Note from the Filter tab. The output choices are CSV, PDF and HTML. 

Filter Parameters 
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You can filter on pull-down status, initiative, alignment node, finances, project basics, project 
dates, organization hierarchy, project custom fields, and classification fields. 

Output Parameters 

The available report formats are: CSV, PDF, and HTML  

Sample Report 

 
 

Project Summary By Project Source 
Based on your filters, this report displays the finance summary by project source. It displays 
project source, project count (active and closed) and project finances. Before running this report, 
you must choose a Finance Template from the Filter tab.  

Filter Parameters 

You can filter on pull-down status, initiative, finances, organization hierarchy, project basics, 
project dates, classification fields, project custom fields, and alignment trees. 

Output Parameters 

The available report formats are: CSV, PDF, and HTML  

Sample Report 

 
 

Project Summary By Functional Area 
Based on your filters, this report displays the finance summary by functional area. It displays the 
functional area, project count (active and closed) and project finances. Before running this report, 
you must choose a Finance Template from the Filter tab. 

Filter Parameters 

You can filter on pull-down status, initiative, finances, organization hierarchy, project basics, 
project dates, classification fields, project custom fields, and alignment trees. 

Output Parameters 
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The available report formats are: CSV, PDF, and HTML  

Sample Report 

 
 

Project Summary By Process Area 
Based on your filters, this report displays the finance summary by process area. It displays the 
process areas, project count (active and closed) and project finances. Before running this report, 
you must choose a Finance Template from the Filter tab. The output choices are CSV, PDF and 
HTML. 

Filter Parameters 

You can filter on pull-down status, initiative, finances, organization hierarchy, project basics, 
project dates, classification fields, project custom fields, and alignment trees. 

Output Parameters 

The available report formats are: CSV, PDF, and HTML  

Sample Report 

 
 

Project Summary Stats by Role 
Based on your filters, this report displays the project summary statistics by resource roles. Before 
running this report, you must choose an Initiative from the Filter tab. 

Filter Parameters 

You can filter on pull-down status, initiative, reporting date range, organization hierarchy, and 
finances. 

Output Parameters 
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You can choose the report format, if you want to compress the output by generating a .zip file, and 
include or exclude graphs from the report. 

The available report formats are: CSV, PDF, and HTML  

Sample Report 

 
 

Closed Project Listing 
Based on your filters, this report displays all closed projects. It displays the initiative, project 
number, name and planned project close date and project type. 

Filter Parameters 

You can filter on pull-down status, initiative, organization hierarchy, and finances. 

Output Parameters 

You can choose the report format and if you want to compress the output by generating a .zip file. 

The available report formats are: CSV, PDF, and HTML  

Sample Report 

 

  31 

 



Reports User's Guide  
 
 

Active/Closed Project Report 
Based on your filters, this report displays all active and closed projects. It displays the initiative, 
project number, name, close date, project type, and the finances associate with the project. 

Filter Parameters 

You can filter on pull-down status, initiative, organization hierarchy, and finances. 

Output Parameters 

You can choose the report format and if you want to compress the output by generating a .zip file. 

The available report formats are: CSV, PDF, and HTML  

Sample Report 

 
 

Project Report (Detail Reports) 

In This Section 

Project Listing Report with Activity List .................................................................... 33 
Project Final Report ................................................................................................. 33 
Project Review Report ............................................................................................. 34 
Project Control Report ............................................................................................. 35 
Project Notes Report ............................................................................................... 36 
Project Issues Report .............................................................................................. 37 
Project Storyboard ................................................................................................... 38 
Idea Evaluation Report ............................................................................................ 38 
Proposal Evaluation Report ..................................................................................... 39 
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Project Listing Report with Activity List 
Based on your filters, this report displays the projects by resource roles. It displays the project 
manager, project name, project ID, completion, status, type, YTD realized benefits, current 
forecast, % estimated savings, % defect reduction, and defect % of entitlement.  Before running 
this report, you must choose an Initiative and Resource Role from the Filter tab. 

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, organization hierarchy, and 
finances. 

Output Parameters 

You can select the report format and if the output should be compressed. The available report 
formats are CSV, PDF and HTML.  

Sample Report 

 
 

Project Final Report 
Based on your filters, this report displays the project final report. It displays the project definition, 
project summary, project details, stage conclusions, team members, control plan tasks, project 
documentation, and custom fields. 

Filter Parameters 

You can filter on pull down status, initiative, project basics, organization hierarchy, project custom 
fields, and finances. 

Output Parameters 

You can select the report format, maximum number of rows to display per report, and if the output 
should be compressed. The available report formats are CSV, PDF and HTML.  
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Sample Report 

 
 

Project Review Report 
Based on your filters, this report displays the aggregate project review report. It displays the 
project name, project activities, analysis tools, issues, and custom fields. 

Filter Parameters 

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields. 

Output Parameters 

You can select the report format, maximum number of rows to display per report, and if the output 
should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report 

 
 

Project Control Report 
Based on your filters, this report displays the project control report.  

Filter Parameters 

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields, classification fields. 

Output Parameters 

You can select the report format, maximum number of rows to display per report, and if the output 
should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report 

 
 

Project Notes Report 
Based on your filters, this report displays the project notes report. The output choices are PDF and 
HTML. 

Filter Parameters 

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields. 

Output Parameters 

You can select the report format, maximum number of rows to display per report, and if the output 
should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report 

 
 

Project Issues Report 
Based on your filters, this report displays the project issues report. The output choices are PDF 
and HTML. 

Filter Parameters 

You can filter on pull-down status, initiative, project basics, organization hierarchy, and project 
custom fields. 

Output Parameters 

You can select the report format, maximum number of rows to display per report, and if the output 
should be compressed. The available report formats are: CSV, HTML, and PDF.  
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Sample Report 

 
 

Project Storyboard 
Based on your filters, a project storyboard is created. The output option is MS PowerPoint. Follow 
the instruction under the Help tab to export project data to Microsoft PowerPoint. 

Filter Parameters 

You can filter on pull down status, initiative, project basics, project dates, organization hierarchy, 
project custom fields, finances, and storyboard. 

Output Parameters 

You can select the maximum number of projects to display and the report format. The available 
report format is MS PowerPoint.  
 

Idea Evaluation Report 
Based on your filters, this report displays the evaluation of all ideas in the system.  

Filter Parameters 

You can filter on pull down status, idea basics, organization hierarchy and idea custom fields. 

Output Parameters 
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You can select the report format, maximum number of rows to display per report, and if the output 
should be compressed. The available report formats are CSV, PDF and HTML.  

Sample Report 

 
 

Proposal Evaluation Report 
Based on your filters, this report displays the evaluation of all charters in the system.  

Filter Parameters 

You can filter on pull down status, initiative, proposal basics, classification fields, and organization 
hierarchy. 

Output Parameters 

You can select the report format and if the output should be compressed. The available report 
format choices are CSV, PDF and HTML.  
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Sample Report 

 
 

Project Reports (Spreadsheet Reports) 

In This Section 

Project Finance Spreadsheet Report ....................................................................... 40 
Project Detail Spreadsheet Report .......................................................................... 41 
Financial Savings by Business Unit ......................................................................... 42 
Finance Aggregate Reports ..................................................................................... 43 
 
 

Project Finance Spreadsheet Report 
You can generate the project finance report using the filter and output options. The report is 
displayed in Microsoft Excel. You must first download the template. 

Filter Parameters 

You can filter on pull down status, initiative, project basics, classification fields, organization 
hierarchy, and finances. 

Output Parameters 

You can select the report format, the maximum rows per report, and compress output. The report 
output is in CSV format. 
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Sample Report 

 
 

Project Detail Spreadsheet Report 
This report displays a detailed project report. The report is displayed in Microsoft Excel. You must 
first download the template. 

Filter Parameters 

N/A 

Output Parameters 

The output is in CSV format. 
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Sample Report 

 
 

Financial Savings by Business Unit 
You can generate a financial savings report by business unit using the filter and output options. 
The report is displayed in Microsoft Excel. 

Filter Parameters 

You can filter on initiative and finances. 

Output Parameters 

You can select the report format and choose to compress the output. The output is in CSV format. 

Sample Report 
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Finance Aggregate Reports 
The Finance Aggregate Reports can be very useful to your business as they can be customized to 
your needs. Using EnterpriseTrack you can extensively configure finance reports by configuring 
the level of group, category, and element details. You can also configure based on time period 
(annual versus monthly), and by optional use of lock months. Also, your finances may involve 
separate Plan versus Actual, or a single set of numbers that starts off as Plan and then is updated 
each month into Actual for the previous months. You can create snapshots for comparisons by 
keeping the prior values. Regardless of how you are currently using the Finance module, the three 
Finance Aggregate Reports can be configured with the use of a small set of filters to create a 
report output that is best suited to your needs. You can also use these reports as data sources to 
generate highly specific output in the form of Excel charts, pivot table and any company-style 
formatted output (See topic Creating User-Defined Excel Reports). 

The three Finance Aggregate Reports provide increasing levels of detailed information. They also 
provide extensive columns of non-financial information about projects such as– organization, 
classification, users, custom fields, etc. The hierarchy of finance information can be visualized as:  

Total 

 Group1 

  Category 1.1 

   Element 1.1.1 

Total refers to the sum-total finance value of a Project. Group1, 2,3,4,5 refers to the items in the 
Finance Template hierarchy you have configured just below the Total level. Categories are the 
items below Groups and Elements are the items below Categories.  

Sample Report 
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The sample below is an example of what you can do by using the data generated from the Finance 
Aggregate Reports as data sources to create custom generated user reports. 

 

In This Section 

Project Finance Group Aggregate ........................................................................... 44 
Project Finances Element Aggregate ...................................................................... 45 
Project Finances Element Monthly Detail ................................................................ 46 
 
 

Project Finance Group Aggregate 
You can generate a finances group aggregate report by using the filter and output options. The 
report is displayed in Microsoft Excel. The output is in MS-Excel format. For more information on 
filtering, see topic Using Finance Aggregate Report Filters. 

It displays:  

 New financial columns that sum up the Group1-5 and Total values over a chosen date range 
and chosen from actual, plan, before/after lock based on the filter settings. 

 1 project per row. 
 Aggregates and does not show monthly details. 

Filter Parameters 

You can pull down status, initiative, project basics, project organization hierarchy, project dates, 
project classification fields, project custom fields, programs, finances, and finance aggregate 
definition. 

Output Parameters 

You can select the report format and choose to break down finance details by organization. The 
output is in CSV format. 
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Sample Report 

 
 
 

Project Finances Element Aggregate 
You can generate a finances element aggregate report by using the filter and output options. The 
report is displayed in Microsoft Excel. The output is in MS-Excel format. For more information on 
filtering, see topic Using Finance Aggregate Report Filters. 

It displays:  

 New financial columns that sum up the Group1-5 and Total values over a chosen date range 
and chosen from actual, plan, before/after lock based on the filter settings. 

 Multiple projects per row. One row is shown for each configured item in the Finance Template 
hierarchy. 

 Aggregates and does not show monthly details. 

Filter Parameters 

You can pull down status, initiative, project basics, project organization hierarchy, project dates, 
project classification fields, project custom fields, programs, finances, and finance aggregate 
definition. 

Output Parameters 

You can select the report format and choose to break down finance details by organization. The 
report output format choices are CSV, HTML, and MS Excel. 
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Sample Report 

 
 
 

Project Finances Element Monthly Detail 
You can generate a finances element monthly detail report by using the filter and output options. 
The report is displayed in Microsoft Excel. The output is in MS-Excel format. For more information 
on filtering, see topic Using Finance Aggregate Report Filters. 

It displays:  

 Month by month values for the date range based on the filter settings. 
 Multiple projects per row. One row is shown for each configured item in the Finance template 

hierarchy. 

Filter Parameters 

You can pull down status, initiative, project basics, project organization hierarchy, project dates, 
project classification fields, project custom fields, programs, finances, and finance aggregate 
definition. 

Output Parameters 

You can select the starting month, number of months, report format and choose to break down 
finance details by organization. The report output format choices are CSV, HTML, and MS Excel. 
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Sample Report 

 
 
 

Resource Reports (Detail Reports) 

In This Section 

Resource Professional Certifications ....................................................................... 47 
Resource Expertise/Skills ........................................................................................ 48 
Resource Assets ..................................................................................................... 49 
Heat Map by Resource ............................................................................................ 50 
Heat Map by Role .................................................................................................... 51 
Heat Map by Role .................................................................................................... 52 
Resource Utilization Chart ....................................................................................... 53 
Project Effort Chart .................................................................................................. 54 
Heat Map by Resource CSV.................................................................................... 55 
Heat Map Legends .................................................................................................. 55 
 
 

Resource Professional Certifications 
Based on your filters, this report displays all the certificates received by resources.  

Filter Parameters 

You can filter on pull down status, initiative, resource basics, and organization hierarchy. 

Output Parameters 
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You can select the primary output column to sort by, sort direction, maximum number of rows to 
display per report, and if the output should be compressed. The output choices are CSV, PDF and 
HTML.  

Sample Report 

 
 

Resource Expertise/Skills 
Based on your filters, this report displays the skills and expertise the resources have.  

Filter Parameters 

You can filter on pull down status, initiative, resource basics, and organization hierarchy. 

Output Parameters 

You can select the primary output column to sort by, sort direction, maximum number of rows to 
display per report, and if the output should be compressed. 

The output choices are CSV, PDF and HTML. 

48 

 



 About Standard Reports  

Sample Report 

 
 

Resource Assets 
Based on your filters, this report displays all resource assets. 

Filter Parameters 

You can filter on pull down status, initiative, resource basics, and organization hierarchy. 

Output Parameters 

You can select the primary output column to sort by, sort direction, maximum number of rows to 
display per report, and if the output should be compressed. The output choices are CSV, PDF and 
HTML.  

The output choices are CSV, PDF and HTML. 
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Sample Report 

 
 

Heat Map by Resource 
Based on your filters, this report displays a heat map by resource. It displays the resource/project, 
project count, planned effort for resources (PL), actual effort for resource (AC), planned utilization 
(PL/CP %), and the actual utilization (AC/CP %). For more information on the heat map thresholds 
used and a description of the column headers, click the Legend link. The cells highlighted in green 
indicate that the resource is under utilized, and cells highlighted in red indicate that the resource is 
overbooked.  

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, and proposal custom 
fields 

Output Parameters 

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format choices are CSV and HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, and 
display team/overhead. 

 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 

The output choices are CSV and HTML. 

50 

 



 About Standard Reports  

Sample Report 

 
 

Heat Map by Role 
Based on your filters, this report displays a heat map by resource roles. From the Filter tab, you 
must choose an Initiative before running this report.  It displays the role/ resource/project, project 
count, planned effort for resources (PL), actual effort for resource (AC), planned utilization (PL/CP 
%), and the actual utilization (AC/CP %). For more information on the heat map thresholds used 
and a description of the column headers, click the Legend link. The cells highlighted in green 
indicate that the resource is under utilized, and cells highlighted in red indicate that the resource is 
overbooked.  

Note: The total capacity at the role level only indicates potential capacity. 
The capacity is counted more than once if a resource has multiple roles. 

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal organization 
hierarchy, and proposal custom fields 

Output Parameters 

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format choice is HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, and 
display team/overhead. 

 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 
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The report output format is HTML. 

Sample Report 

 
 

Heat Map by Role 
Based on your filters, this report displays a heat map by project.  It displays the project/resource, 
resource count, planned effort for resources (PL), actual effort for resource (AC), planned 
utilization (PL/CP %), and the actual utilization (AC/CP %). For more information on the heat map 
thresholds used and a description of the column headers, click the Legend link. If your report has 
a cell highlighted in orange, it indicates that the committed effort as a percentage of capacity for 
the activity is in the mid-range. If a cell is highlighted in red, it indicates that the activity's planned 
utilization is very high, and cells highlighted in green indicate very low utilization. 

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal organization 
hierarchy, and proposal custom fields 

Output Parameters 

You can select the following filters: 

 Display Filters: report format, maximum rows per report, rows per page, and hide rows with 
zero effect. The report format choice is HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, and 
display team/overhead. 
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 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 

The report format choice is HTML.  

Sample Report 

 
 

Resource Utilization Chart 
Based on your filters, this report displays the resource utilization. It shows the planned utilization 
% and the actual utilization % for all resources. 

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal organization 
hierarchy, and proposal custom fields 

Output Parameters 

You can select the following filters: 

 Display Filters: report format, maximum rows per report, compress output, and display 
resource level chart. The report format is HTML.  

 Chart Filters: display % utilization, display planned, display actual, and display capacity. 
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Sample Report 

 
 

Project Effort Chart 
Based on your filters, this report displays project effort by project. It shows the planned and the 
actual effort. 

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal organization 
hierarchy, and proposal custom fields 

Output Parameters 

You can select the following output filters: 

 Display Filters: report format, maximum rows per report, and compress output. The report 
format is HTML.  

 Chart Filters: display planned, and display actual. 

Sample Report 
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Heat Map by Resource CSV 
Based on your filters, this report displays a heat map by resource.  

Filter Parameters 

You can filter on pull down status, initiative, reporting date range, resource basics, resource 
filterable custom fields, resource organization hierarchy, project basics, project dates, project 
organization hierarchy, project finances, program, project custom fields, project classification 
fields, project alignment tree, proposal basics, proposal classification fields, proposal organization 
hierarchy, proposal custom fields, and program. 

Output Parameters 

You can select the following filters: 

 Display Filters: report format, maximum rows per report, and hide rows with zero effect. The 
report format choices are CSV, XLS, and HTML.  

 Row Filters: display named resource, display TBD assignments, display projects, display 
proposals, display assigned allocations, display unassigned allocations, display activities, and 
display team/overhead. 

 Column Filters: display project count, display capacity, display requested, display committed, 
display total demand, display percent allocations/approvals, display planned, display actual, 
and display percent utilization. 

The output choices are CSV, XLS, and HTML. 

Sample Report 

 
 

Heat Map Legends 
 CP(hours)  

Resource Capacity. The number of working hours per week by a resource divided by the 
number of working days per week.  
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Example: If a user works 40 hours a week, there are 5 work days in a week and 22 working 
days in a month, then the capacity for the resource for that month is 40/5* 22= 176 hours. 
Resource capacity is fixed and the number of work days in EnterpriseTrack is fixed at 5. 
General calendar holidays and non-working days do not affect resource capacity. 

 RQ(hours) 
 Pending/Unapproved Requested Effort for Resources. It is the sum of the demand for a role 
or resource in the form of allocations from projects. 

 CM(hours) 
Approved/Committed Effort for Resources. When Requested Effort (RQ) is approved it 
becomes Committed Effort and RQ can be approved is full or partial. If a resource role doesn't 
require an approved then as soon as effort is allocated it becomes committed effort. 

 TD(hours)  
Total Demand (RQ+CM). It is the sum of Requested Effort (RQ) for a role or resource and the 
Committed Effort (CM).  

 RQ/CP(Percent) 
Requested Effort as a percent of Capacity. 

 CM/CP(Percent) 
Committed Effort as a percent of Capacity. 

 TD/CP(Percent)  
Total Demand as a percent of Capacity. 

 PL(hours) 
Planned Effort for Resources. The sum of an individual resource's planned effort for each 
assigned task for a given time period. It is not double-counted when rolled up by resource or 
role.  
 
Example: If John Smith plans to work 110 hours as a DBA and 40hrs as a Unix Administrator 
for the month of January, then the PL for John for the month of January is 110 +40 = 150 
hrs.  If Mary Jane plans to work 100 hrs. as a DBA in the month of January then the PL for 
DBA is 110 + 100= 210 hrs. The PL for Mary is 100 hrs. The PL for Unix Administrator is 40 hrs. 

 AC(hours)  
Actual Effort. The sum of the actual effort by a resource for a given time period. This can come 
from timesheets. No double counting is done when rolled up by resource or role.  
 
Example: If John Smith has worked 93 hrs. as a DBA and 45 hrs. as a Unix Administrator in 
January, then the AC for John is 93+45 = 138 hrs. If Mary Jane worked 97 hrs. as DBA in 
January, then the AC for Mary is 97. The AC for DBA is 93+97=190 and the AC for Unix 
Administrator is 45. 

 PL/CP(Percent)  
Planned Utilization. 

 AC/CP(Percent) 
Actual Utilization. 
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Timesheet Reports 
Timesheet Report by Project 
Based on your filters, this report displays timesheet reports by projects. It displays the project 
name, role, team member, activities, the number of hours reported on timesheet, total hours, rate, 
and cost.  If the date range is one week or less, the generated report provides a detailed view for 
each day of the week. If the date range is more than a week, the generated report displays a 
summarized view for the entire period. 

Filter Parameters 

You can filter on pull down status, initiative, project basics, timesheet basics, organization 
hierarchy, and finances. 

Output Parameters 

You can choose to compress the output, display cost, display project overhead categories and 
activity details, and hide rows with zero effect. The available report format choices are: CSV, PDF 
and HTML. 

Sample Report 

 
 

Timesheet Report by Resource 
Based on your filters, this report displays timesheet report by resource. It shows the resource 
name, project name, role, activities, the number of hours reported on timesheet, total hours, rate, 
and cost.  

Filter Parameters 
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You can filter on pull down status, initiative, resource basics, resource filterable custom fields, 
organization hierarchy, timesheet basics, and finances. 

Output Parameters 

You can choose to compress the output, display cost, display project overhead categories and 
activity details, display non project overhead categories, and hide rows with zero effect. The 
available report  

The available report format choices are: CSV, PDF and HTML. 

Sample Report 

 
 

Timesheet Detail Report 
This is a detailed report of timesheets. You can export the data generated by this report to 
Microsoft Excel to view the Plan versus Actual data and the cost across various dimensions. You 
can use Excel to format the data, group rows and columns, aggregate by quarters, years, or by 
fiscal period. 

Notes:  

 The Total Plan Effort column in this report is an information only 
column and the value will be the whole plan effort at activity level. This 
value may be repeated when the report is run to show the breakdown 
at day level, in such cases care should be taken not to double count 
the plan effort. 
 

 The cost data is shown only for users that have the required 
permissions to view cost information. 
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 The resource rates are picked for the rate at assignment level. For 
non-project time and non-working time the standard rate at the 
resource level is used. 
 

 If the correction dates are specified, the output will display correction 
reports. If correction dates are not specified, the output will display 
timesheet time and cost. If both correction dates and timesheet dates 
are specified, the corrections reported will be for the timesheets filed 
within the specified timesheet dates. 
 

 If the resource plays more than one role in a project or an activity, the 
time reported from the timesheet will be equally distributed among all 
the roles and then costed with the respective role rate. 

Filter Parameters 

You can filter by Pull-down Status, Initiative, Timesheet Basics, Correction Date Range, Project 
Basics, Project Organization Hierarchy, Resource Basics, Resource Organization Hierarchy, 
Resource Filterable Custom Fields, Finances, Program, and Output Custom Fields.  

Output Parameters 

You can also set the following output filters: Compress Output, Show Cost, Show Project 
Overhead Categories, Show Activity Details Show Non-project Categories, Include disabled Time 
Reporting Categories, Show Actual Effort breakdown at day level, and Suppress rows where 
Actual Total Effort is zero. If you select the Show Actual Effort breakdown at day level option, the 
report displays the actual effort by resource assignment for each day. Leave this option 
unchecked to view actual effort aggregated for the selected time period.  

The output choices are CSV, PDF, and HTML with compression. 

Sample Report 
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User-Defined Excel Reports (also referred to as Composite reports) combines Microsoft Excel (as 
a tool for creating charts, pivot tables and tabular data in a highly customer-specific format) and 
EnterpriseTrack (as a single location repository for all users and a source of the latest real-time 
data from across your entire organization on your projects and related information such as status, 
charters and finances). As a result, your organization can enjoy the flexibility and control of your 
favorite desktop tool and the data reliability and productivity of a centralized on-demand source of 
project and portfolio information.  

For example, you can use User-Defined Excel reports if you need a Pivot Table report of Projects 
Finances by Organization and also display on the same page a chart of Project Finances by Time. 
Once you are setup with an Excel report template, you can then run the Pivot Table report as often 
as needed to access the updated report fed with the latest data from the system in an Excel output 
format.  

You can create custom reports using one or more Ad-hoc templates as inputs and you can choose 
to output it as an XLS or as a zip file. One or more Ad-hoc report outputs can be inserted into 
separate sheets in Microsoft Excel. You can also view the history, email and share these reports.  

In This Section 

Creating User-Defined Reports ............................................................................... 60 
 
 

Creating User-Defined Reports 

To create User-Defined Reports, do the following:  

1) Navigate to Standard Reports by selecting Go To >Reports >Standard from the Top 
Navigation bar. 

2) From the Tree pane, select the My Report folder and select any reports sub-folder 
underneath. If you don’t have a sub-folder underneath the My Report folder, then you must first 
create a sub-folder. For example, you can create a sub-folder called Excel-Based Report. 

3) From the List pane, click the  Create User-Defined Report button, and choose 
User-Defined Excel Report. 

4) From the General tab enter a name for the report. 
5) From the Data Source tab, you can add, or delete one or more Ad-hoc templates or you can 

select any of the available Standard Report templates. The Standard Reports that are 
displayed are the ones that have a tabular output. Most reports do, but those that have only a 
PDF output are not shown in the list of available reports.  

Notes: 

User Defined Excel Reports 
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 You must choose a report that does not require any parameters at 
run-time. The report should produce an output without setting any 
parameters. 

 It is recommended that you make a copy of the Standard Report that 
you want to use as a data feed into your My Reports folder. This way 
you can set all necessary parameters that the Standard Report may 
need. If you are using Ad-hoc reports, you should similarly ensure that 
the reports do not require any input parameters 

6) Enter a name, select a source template, and enter an Order ID. You can click on the Add More 
link to add more source templates. This name will become the name of the tab in the output 
Excel report 

7) The Source is where you specify the Ad-hoc or Standard report templates that will be used as 
the data source to feed into your Report Template. You can have several sources of Ad-hoc or 
Standard reports. 

8) From the Output tab select the report format (XLS or ZIP). Select if you want to edit the 
parameters during runtime. 

9) Click  Run Report.  
You can open the report in Excel and add your own tabs. Your tabs can contain any Excel 
formulas, coloring, borders, text, charts, pivot tables and even Macros. These can refer to cells 
in the EnterpriseTrack data feed tabs.  

Note: You should not make any changes or edits to the tabs fed from 
EnterpriseTrack – these will be lost in a subsequent run of the report. You 
can however make any number of your own tabs. These tabs can have 
formulas that refer to the tabs of data fed by EnterpriseTrack. In this way 
you can create any arbitrary Excel output you wish. Note that when you 
refer to data ranges in the data tabs from EnterpriseTrack, you should 
know that there may be fewer or more rows in each run of the report 
depending on the underlying data set chosen. This can often be handled 
by just naming the column of data as the range in the Excel formula (e.g. 
A: A or C: C). 

10) From the Details tab, click on the General tab and upload the file you created in the previous 
step as the Report template. This template will then be populated at the next execution of the 
report, with the latest data. If you wish to change the template by modifying its appearance or 
any formulas, you can re-upload the modified template at any time. 

11) From the Output tab select the report format (XLS or ZIP). Select if you want to edit the 
parameters during runtime. 

12) Click the Save button. 
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To access a set of pre-defined Ad-hoc Report templates, from the Top Navigation bar select Go 
To> Reports > Ad-hoc. 

You can also use the Left Navigation bar to select Reports > Ad-hoc Reports. 

In This Section 

Managing Ad-Hoc Reports ...................................................................................... 62 
List of Ad-Hoc Reports ............................................................................................ 63 
 
 

Managing Ad-Hoc Reports 

You can edit the predefined templates by specifying the parameter values, selecting the columns 
to display, and specifying the sort orders. You can also view saved templates created by other 
users by changing the filter criteria. 
 

Editing Templates 

To edit a template, click on the [Edit] link next to the template. Click on the tabs to modify the 
report and click on the Save As… button. 

General Tab 

Modify the name, and description. Select if you want the default output parameter to be HTML, 
PDF, XLS, or XML. Also select if you want to publish this report. 

Parameters Tab 

Select the parameters and their values. You can choose to edit the parameter at runtime. 

Column Selection Tab 

Select the columns you want to display. Click the right or left buttons to select/omit columns from 
the report. You can also use the Move Up and Move Down buttons to change the order of the 
selected columns.  

Column Details Tab 

Select the column name and enter a description. 

Sorting Tab 

Select the sorting order for the columns. 

Run Test Report 
Select the output format (HTML, PDF, XLS, or XML) and enter values for any required 
parameters. Click the Run Report button. 

Ad-Hoc Reports 
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Copying Templates 

To copy an existing template: 

1) Click the [Edit] link next to the template you want to copy. 
2) Click on the tabs to modify the report and  
3) Click the Save As… button.  
4) Enter a name and description for this report.  
5) Select if you want publish this report. 
6) Click Save. 
 

To set filters: 

1) Click the More Filters… button. 
2)  Select the scope, and enter the filter criteria. 
3) Click the Apply.  
 

To run an Ad-hoc report:  

1) Select a report and click on the [Run] link. 
2) From the Run Ad-hoc Report screen, select the output parameter and enter any mandatory 

parameters. 
3) Click the Run Report button. The screen refreshes to display the report. 
 

List of Ad-Hoc Reports 

The table below lists the pre-defined ad-hoc reports. 

Report Name Description/Purpose 

Asset Listing Report Get all the asset related information for all resources. 

Charter Template A template for charter reports. 

Executive Notes Listing 
Template 

Lists all executive notes. 

Finance Validation Report 
Template 

Display finance validation data. 

Idea Template A template for idea reports. 

Issues Listing Report Lists issues in all projects. 

Metrics Listing Report Get all the metrics related information for all projects. 

Program Template A template for program reports. 

Project & Metrics Template This template combines project and metrics data. 

Project Listing Report Displays project details including a list of key team 
members. 
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Report Name Description/Purpose 

Project Template A template for project reports. 

Charter Team Member 
Listing Report 

Lists all charter team members. 

Resource Certification 
Listing Report 

Lists all certifications taken by resources. 

Resource Template A temple for resource reports. 

Role Based Permission List Lists all role based permissions. 

Team Member Listing 
Report 

Lists all team members. 

Title Based Permission List Display all title based permission mapping. 
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Where to Get Documentation 

Complete documentation libraries for EnterpriseTrack releases are available on the Oracle 
Technology Network (OTN) at: 

http://www.oracle.com/technetwork/documentation/default-1956119.html 

From this location you can either view libraries online or download them to have local copies. We 
recommend viewing them from OTN to ensure you always access the latest versions, including 
critical corrections and enhancements.  

EnterpriseTrack is configured to access its help system directly on OTN. However, a 
downloadable version of the help system is also available on OTN if you need to download, 
deploy, and access a local copy. 

The documentation assumes a standard setup of the product, with full access rights to all features 
and functions. 

The following table describes the core documents available for EnterpriseTrack and lists the 
recommended readers by role. 

For More Information 
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Title Description 

EnterpriseTrack User 
Help 

Describes how to work with EnterpriseTrack and provides 
information to assist users with using EnterpriseTrack 
features. 
All users should read this Help. 

EnterpriseTrack 
Administrator's Help 

Describes how to work with EnterpriseTrack Administrator's 
console to manage your deployment and change various 
aspects of the application. 
EnterpriseTrack administrator should read this Help. 

EnterpriseTrack User 
Guide 

Guides users on how to use the EnterpriseTrack application. 
All users should read this guide. 

EnterpriseTrack 
Administrator's Guide 

Provides detailed information on using the EnterpriseTrack 
Administrator's console. 
EnterpriseTrack administrator should read this guide. 

EnterpriseTrack 
Dashboards User's 
Guide 

Provides detailed instruction on using the EnterpriseTrack 
Dashboards modules to view and generate dashboards.  
All users should read this guide. 

EnterpriseTrack Reports 
User's Guide 

Provides detailed instruction on using the EnterpriseTrack 
Reports modules to generate standard reports, ad-hoc 
reports and user-defined reports. 
All users should read this guide. 

EnterpriseTrack Quick 
Reference Guide 

Provides a quick introduction to common EnterpriseTrack 
tasks. 
All users should read this guide. 

EnterpriseTrack 
Installation Guide 

Provides information on how to install and configure 
EnterpriseTrack.  
EnterpriseTrack administrator, network administrator and 
database administrator should read this guide. 

EnterpriseTrack  MSP 
Integration Guide 

Provides an overview of MS Project integration for 
EnterpriseTrack. 
EnterpriseTrack users who will perform MS Project 
integration should read this guide. 

EnterpriseTrack API 
Integration Guide 

Provides information that allows customers to customize 
existing third-party integration. 
Developers interested in customization and existing 
third-party providers that integrate with EnterpriseTrack 
should read this book. 
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Title Description 

EnterpriseTrack Upgrade 
Guide 

Provides a sequence of procedures that must be completed 
to upgrade to a new version of EnterpriseTrack.  
EnterpriseTrack administrator and database administrator 
should read this guide. 

EnterpriseTrack 
Architecture Data Sheet 

Provides the server system requirements and the deployment 
configuration options for EnterpriseTrack. 

EnterpriseTrack Tested 
Configurations 

Lists the configurations that have been tested and verified to 
work with EnterpriseTrack.  
EnterpriseTrack administrator, network administrator, and 
database administrator should read this guide. 

EnterpriseTrack 
Cumulative Features 
Overview Tool 

Provides an overview of features and enhancements included 
in the Oracle EnterpriseTrack product. It is intended solely to 
help you assess the business benefits of upgrading. 
All users should read this guide. 

EnterpriseTrack Security 
Guide 

Provides guidelines on how to plan your security strategy for 
EnterpriseTrack. 
All users, EnterpriseTrack administrators, network 
administrators and database administrators should read this 
guide. 

Distributing Information to the Team 
You can copy the online documentation to a network drive for access by project participants. Each 
team member can then view or print those portions that specifically relate to his or her role in the 
organization. 

Throughout this documentation, the Security Guidance icon  helps you to quickly identify 
security-related content to consider during the installation and configuration process. 

 
 

Where to Get Training 

To access comprehensive training for all Primavera products, go to: 

http://education.oracle.com 

Oracle Learning Library 
The Oracle Learning Library (OLL) provides online learning content covering Primavera products. 
Content includes videos, tutorials, articles, demos, step-by-step instructions to accomplish 
specific tasks, and  self-paced interactive learning modules. 
 
To access the learning library’s Primavera content, go to:  

http://www.oracle.com/oll/primavera 
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Where to Get Support 

Access to Oracle Support 
Oracle customers have access to electronic support through My Oracle Support. For information, 
visit http://www.oracle.com/us/support/contact-068555.html or visit 
http://www.oracle.com/us/corporate/accessibility/support/index.html if you are hearing impaired. 

Using Primavera's Support Resource Centers 
Primavera’s Support Resource Center provides links to important support and product 
information. Primavera's Product Information Centers (PICs) organize documents found on My 
Oracle Support (MOS), providing quick access to product and version specific information such as 
important knowledge documents, Release Value Propositions, and Oracle University training. 
PICs also offer documentation on Lifetime Management, from planning to installs, upgrades, and 
maintenance. 

Visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=1486951.1 to access links to 
all of the current PICs. 

PICs also provide access to: 

 Communities are moderated by Oracle providing a place for collaboration among industry 
peers to share best practices.  

 News from our development and strategy groups. 
 Education contains a list of available Primavera product trainings through Oracle 

University. The Oracle Advisor Webcast program brings interactive expertise straight to the 
desktop using Oracle Web Conferencing technology. This capability brings you and Oracle 
experts together to access information about support services, products, technologies, best 
practices, and more.  

For more information about working with Support, visit 
https://support.oracle.com/epmos/faces/DocumentDisplay?id=888813.2. 
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Copyright © 2000, 2014, Oracle and/or its affiliates. All rights reserved. 
Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be 
trademarks of their respective owners. 

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or 
decompilation of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this is software or related documentation that is delivered to the U.S. Government or anyone 
licensing it on behalf of the U.S. Government, the following notice is applicable:  

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated 
software, any programs installed on the hardware, and/or documentation, delivered to U.S. 
Government end users are “commercial computer software" pursuant to the applicable Federal 
Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, 
disclosure, modification, and adaptation of the programs, including any operating system, 
integrated software, any programs installed on the hardware, and/or documentation, shall be 
subject to license terms and license restrictions applicable to the programs. No other rights are 
granted to the U.S. Government. 

This software or hardware is developed for general use in a variety of information management 
applications. It is not developed or intended for use in any inherently dangerous applications, 
including applications that may create a risk of personal injury. If you use this software or hardware 
in dangerous applications, then you shall be responsible to take all appropriate failsafe, backup, 
redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates 
disclaim any liability for any damages caused by use of this software or hardware in dangerous 
applications. 

This software or hardware and documentation may provide access to or information on content, 
products and services from third-parties. Oracle Corporation and its affiliates are not responsible 
for and expressly disclaim all warranties of any kind with respect to third-party content, products, 
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or 
damages incurred due to your access to or use of third-party content, products, or services. 
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